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Introduction

This Installation and Configuration Guide is divided into four parts:

System Requirements and Pre-Installation. This section describes the
hardware and software requirements required to run Ventura Publisher.
This section also describes pre-installation considerations that need to be
taken into account depending on your system configuration.

Installation. This section describes the steps necessary to install Ventura
Publisher and its components onto your system.

>  Itisvery important that you read through the installation procedures care-
fully both before and during the installation process.

Configuration. This section describes how to register network seats using
the SERNSTAL application, and how to customize the button bar using the
button bar editor application.

Utilities. This section describes how to use the utility programs included
with Ventura Publisher.



System Requirements and Pre-Installation

This section describes the hardware and software requirements required to
run Ventura Publisher.

This section also describes pre-installation considerations that need to be
taken into account depending on your system configuration.
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Basic system requirements

Ventura Publisher for Windows requires an 80286, 80386, or 80486 IBM AT,
PS/2, or compatible computer. Your computer must also contain the fol-
lowing or equivalent:

* Minimum of 4 megabytes of RAM. All RAM above the first megabyte
must be configured as extended memory. It is recommended that 6 to
8MB (or more) system memory be installed for increased performance.

Device drivers, TSR (terminate and stay resident) programs, and print and
disk caching programs loaded before Windows is run subtract from the
total memory available to Windows and Ventura Publisher. Printer and
disk caches may also allow you to specify an amount of memory to reserve
for the cache. If you have device drivers, disk or print caches, or TSR
programs loaded before Windows is run, sufficient memory for running
Ventura Publisher may not be available. In this case you must decrease the
memory used by the print or disk cache, remove the device drivers or TSR
programs from memory before running Windows, or add additional sys-
tem memory.

+ DOS 3.3 or higher.

* Microsoft Windows version 3.0 or higher must be installed prior to
installing Ventura Publisher. Windows version 3.1 or higher is recom-
mended.

* A hard disk drive with at least 5 megabytes of available hard disk space
(after Windows is installed) for the minimal installation of the program
file. A minimum of 6MB additional disk space should be available for
temporary disk space (refer to the AUTOEXEC.BAT entry section
below). Additional hard disk space is required as follows:

Example chapters, 500K bytes
Ventura Scan, 650K bytes

Ventura Separator, 400K bytes

Design Gallery (all categories), 3200K bytes

The capabilities of your display and printer, and the fonts available to
Ventura Publisher depend entirely on the capabilities you have installed for
Windows.
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AUTOEXEC.BAT and CONFIG.SYS entries

AUTOEXEC.BAT

CONFIG.SYS

The following paragraphs describe the minimum entries that should ap-
pear in your AUTOEXEC.BAT and CONFIG.SYS files.

A temporary files storage location must be referenced in your
AUTOEXEC.BAT file as follows:

SET TEMP=[drive:\path]

where [drive:\path] is replaced with the drive and complete path
where you wish Windows to store the temporary files it creates (do not
include the braces in your AUTOEXEC.BAT). The drive must be a valid
drive with at least 6MB of available disk space, and the directory referenced
must be an existing directory.

The drive referenced in the SET TEMP entry should not be a floppy drive
or other removable media. Additionally, the directory referenced in the SET
TEMP entry should not be the root directory of a hard drive (e.g., C:\).

Do not enter any spaces in the entry other than the space between SET and
TEMP.

The following values are recommended for the corresponding
CONFIG.SYS entries.

BUFFERS=10 (If you have a disk cache such as SMARTDrive installed.)
or

BUFFERS=30 (If you don’t have a disk cache program installed.)
FILES=40

DEVICE=[drive:\path] \SMARTDRV.SYS 1024 512

where [drive:\path] is replaced with the drive and complete path
corresponding to the location of the SMARTDRV.SYS file (do not include
the braces in your CONFIG.SYS).

If you use a disk caching utility other than SMARTDrive, replace
[drive:\path] \SMARTDRV.SYS 1024 512 with the location and
parameters for your specific disk caching utility.
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Network system requirements

Stand-alone system accessing the network

In addition to the requirements listed previously, stand-alone systems
accessing the network must also meet the following requirements:

* Inorder for the stand-alone system to access anon-Novell network using
Ventura Publisher, full NetBIOS must be installed on the stand-alone
system.

* Ventura Publisher does not require stand-alone systems accessing the
network to be included in the registered workstation count (refer to the
Workstation Registration section starting on page 17 for information on
workstation registration). However, Ventura Publisher will check the
serial number of all copies of the application accessing the network to
ensure that no two copies of the application having the same serial
number can be run.

Network server and workstation requirements

In addition to the requirements listed previously, the network server and all
workstations running Ventura Publisher Windows Edition from the server
must meet the following requirements:

* On non-Novell networks, full NetBIOS must be installed on the server
and all workstations running Ventura Publisher from the server.

* A separate Network Node Kit or full version of Ventura Publisher must
be purchased for each workstation running Ventura Publisher from the
server.

» Thenumber of workstation users concurrently running Ventura Publish-
er from the server must be equal to, or less than the number of worksta-
tions registered in the registered workstation count (refer to the
Workstation Registration section starting on page 17 for information on
workstation registration).
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Pre-installation

Backing-up the program floppy disks

Before you perform any installation procedures you should backup the
original Ventura Publisher program floppy disks and use the backup copies
for installation. This can be done using the Windows File Manager Copy
Diskette option.

Disabling DOS SHARE

If you are running the DOS SHARE program, you should disable it before
installing Ventura Publisher. Share can be temporarily disabled as follows:

> Exit from Windows.

> Locate and rename SHARE.EXE to SHARE.BAK.

> Reboot your computer.

> Start Windows and perform the installation as described in this guide.

> After the installation is complete, exit from Windows, rename
SHARE.BAK to SHARE.EXE, and reboot your computer.

Installation of different Ventura Publisher Editions on the same drive

Each Ventura Publisher Edition is designed to coexist in the same
VENTURA directory on a single drive. However, it is recommended that
each Ventura Publisher Edition be installed on separate drives.

Installing different Ventura Publisher Editions on the same drive will make
it difficult to isolate the program files for any specific Ventura Publisher
Edition should you wish to delete them at a later time. Additionally,
deleting the INF file for any Ventura Publisher Edition will cause that
version to attempt to load the DEFAULT style sheet located in the TYPESET
directory. If the DEFAULT style sheet is from a 4.0 or above version of
Ventura Publisher, and you have deleted the INF file for a previous version
(e.g., version 3.0) the previous version of Ventura Publisher will attempt to



Creating a
SUBST drive fro
Ventura
Publisher

=

=

load the later version format DEFAULT style sheet resulting in system
hang-up.

If you install the example files from the Ventura Publisher Windows Edition
4.1 in the TYPESET directory, and example files from a different Ventura
Publisher Edition are already installed in the TYPESET directory, the older
files will be overwritten. The example files from Ventura Publisher 4.0 and
above cannot be opened by a previous version of Ventura Publisher.

If you do not have another drive available, you can create one using the
DOS substitute (SUBST) command. This command will allow you to treat
a subdirectory on your drive as another drive. To create a SUBST drive for
Ventura Publisher:

The DOS substitute command should not be used on network systems.

> Ensure that the DOS file SUBST.EXE has been copied to your hard drive.
This file can typically be found in the same location as your other DOS
program files (e.g., the DOS directory).

> Create a directory on your hard disk called VPWIN41. To do this, first
change to a drive that has at least 6MB of free space available. Then, at
the DOS prompt enter:

MD \VPWIN41

> Using an ASCII text editor (Windows Notepad, Sysedit, etc.), enter the
following line in your AUTOEXEC.BAT file

[drivel:\path]\SUBST [newdrive]: [drive2]:\VPWIN41

where [drivel:\path] is replaced with the complete drive and path
location of the SUBST.EXE file. [newdrive] is replaced with the letter
of the drive you are creating (typically the letter after the letter of your
lastdrive. [drive2] is replaced with the letter of the drive on which the
VPWIN41 directory was created.

Do not replace [newdrive] with the drive letter of an existing drive.

For example:
C:\DOS\SUBST E: D:\VPWIN41

In this example, SUBST.EXE is located in the DOS directory of drive C.
The VPWIN41 directory, created on drive D, would be seen by DOS and



Windows as drive E. Additionally, any subdirectories in the VPWIN41
directory would be seen by DOS and Windows and subdirectories of
drive E.

> Save the AUTOEXEC.BAT file and exit from the ASCII text editor pro-
gram.

> If you are in Windows, exit from Windows.

> Reboot your computer for the changes to take affect.

During the Ventura Publisher installation process, you would simply select
the drive created by SUBST (drive E in our example) as the drive on which
to install Ventura Publisher Windows Edition. In this way, your previous
version of Ventura Publisher would still be located in the \VENTURA
directory. The Windows Edition would appear to DOS and Windows as
being installed in the \VENTURA directory of the SUBST drive, but would
actually be installed in a \VPWIN41\VENTURA directory.

Upgrading from earlier versions

Upgrading from Ventura Publisher Windows Edition 4.1 can be installed in a VENTURA
DOS/GEM or directory containing Ventura Publisher DOS/GEM and/or OS/2 Edition
0S/2 Editions program files. If you intend to install Ventura Publisher Windows Edition
in a directory containing other editions of Ventura Publisher, refer to the
section on installing multiple editions on the same drive, starting on page

6, before installing Ventura Publisher Windows Edition 4.1.

If you no longer want to use the older DOS/GEM or OS/2 version, you
should delete all of the program files in the \VENTURA directory and
sub-directories prior to installing the Windows version of Ventura
Publisher.

0> Do not delete any chapter data files in the VENTURA directory. The
Ventura Publisher program files can be identified by the file extension.
Refer to the Reference Guide for the edition you plan to delete for a listing of
the program file and chapter data file extensions.

If you install the example files from the Ventura Publisher Windows Edition
4.1, these files will be installed in the TYPESET directory on the same drive
on which the program files have been installed. If example files from a
Ventura Publisher DOS/GEM or OS/2 Edition are already installed in the
TYPESET directory, they will be overwritten. The example files from
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Windows Edition

Ventura Publisher Windows Edition 4.1 cannot be opened by Ventura
Publisher DOS/GEM or OS/2 Editions.

Attempting to load the Ventura Publisher Windows Edition 4.1 example
files in a DOS/GEM or OS/2 Edition of Ventura Publisher will cause
unpredictable and undesirable results (e.g., system hang-up). If you have
installed the example chapters from the Ventura Publisher DOS/GEM or
OS/2 Editions, and wish to keep these files, you should multi-chapter the
example files to another directory before installing Ventura Publisher
Windows Edition 4.1 example files.

If an older Windows version is already installed, this installation will
overwrite the older application and application support files only. If you
have stored chapter files in the VENTURA directory, this installation will
not delete or modify these files in any way.

If the installation program locates a personal spelling dictionary file in the
directory set as the preferences location, or a VPWIN.INI file in the user’s
Windows directory, the installation program will not overwrite them.

If you are upgrading from Ventura Publisher Windows Edition 4.0, you
should make a backup of the user font index file (USER.WFT) found in the
VENTURA directory in which the 4.0 program files are installed.
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Installation

This section describes steps necessary to install Ventura Publisher and its
components onto your system.

It is important that you read through the System Requirements and
Pre-installation section starting on page 2 before installing Ventura
Publisher Windows Edition 4.1.

After you have completed your installation, please start Ventura Publisher
and refer to page 5-23 of the Reference Guide for information regarding
renaming of the ENVIRON.WID width table file.
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Installing the program

The Ventura Publisher setup application allows you to install all of the
components of Ventura Publisher 4.1, individual components, or install for
a network workstation.

> lf you are upgrading or re-installing a network server installation of
Ventura Publisher, ensure that all network users have exited from Ventura
Publisher and that none are in the VENTURA directory.

If this is a first time installation of Ventura Publisher Windows Edition 4.1,

you will be required to start the setup application from the Ventura
Publisher APPLICATION floppy disk.

If Ventura Publisher Windows Edition 4.1 has previously been installed on
your system, or on a system accessible via a network, the setup application
can be run from the VENTURA directory containing the 4.1 program files.

To install Ventura Publisher Windows Edition 4.1

> Insert the Ventura Publisher APPLICATIONS disk in the appropriate
floppy disk drive.

> With Windows 3.0 or above running, select the Run option from the
Program Manager File menu.

> If you are running the setup application from the APPLICATION pro-
gram disk, enter the following in the Command Line entry field.

[drive] : \SETUP

where [drive] isreplaced with the letter of the floppy drive containing
the APPLICATION program disk.

If you are running the setup application from the VENTURA directory
containing previously installed 4.1 program files, enter the following in
the Command Line entry field.

[drive] : \SETUP2

where [drive] is replaced with the letter of the hard drive containing

the VENTURA directory on which Ventura Publisher Windows Edition
4.1 program files have been installed.

L
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If Ventura Publisher Windows Edition has previously been installed on
your system, open the Ventura Publisher group window. If a setup applica-
tion icon is present in the window, you can double-click on this icon to start
the setup application.

» When the Ventura Publisher setup application starts, the Ventura Pub-
lisher Install dialog box is displayed.

> Click on the desired installation option button. The following pages
describe the components installed, and the option settings associated
with each installation option.

> After the desired installation options have been selected, click on the
Continue button to begin installing the selected components. Insert the
required disks when prompted by the setup application.

The number of disks required for the installation is dependent on the instal-
lation option selected. You may not be required to use all of the program
disks during the installation process.

Complete

The Complete installation option will install the Ventura Publisher applica-
tion files, the Ventura Scan and Ventura Separator application files, and the
example chapters.



The Design Gallery chapters will not be installed using the Complete in-
stallation option. To install Design Gallery chapters, use the Custom instal-
lation option.

When the Complete installation option is selected, the Destination dialog
box is displayed.

. Please select diive on in which to install
 Vomuta Putsher 43, ch to install

. Please enter the loc
. prefetences directory..

> Use the drive select buttons to select the drive on which Ventura
Publisher is to be installed. Ventura Separator and Ventura Scan will be
installed in the VENTURA directory on the selected drive. The example
chapters will be installed in the TYPESET directory on the selected drive.

The dialog box will display the amount of disk space required to install the
program files as well as the amount of disk space available on the selected
drive. If the required disk space is greater than the available disk space, an
alert box will be displayed when the setup application exhausts the avail-
able disk space. However, if you are installing over a previous installation
of Ventura Publisher Windows Edition, the amount of disk space used by
these files is not added to the available space shown. In this situation, there
may be sufficient space available for the installation even though the space
required is greater than the available disk space shown.

> Enter the complete drive and path for the preferences location. This is the
directory in which the personal spelling dictionary (SPLDICT.PD) and
the personal configuration file (VPWIN.INF) is stored. If the directory
specified does not exist, it will be created.

13
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Minimum

Custom

The Minimum install option will install only the Ventura Publisher ap-
plication files. When the Minimum installation option is selected, the
Destination dialog box is displayed.

> Use the drive select buttons to select the network server drive on which
Ventura Publisher is installed.

The dialog box will display the amount of disk space required to install the
program files as well as the amount of disk space available on the selected
drive. If the required disk space is greater than the available disk space, an
alert box will be displayed when the setup application exhausts the avail-
able disk space. However, if you are installing over a previous installation
of Ventura Publisher Windows Edition, the amount of disk space used by
these files is not added to the available space shown. In this situation, there
may be sulfficient space available for the installation even though the space
required is greater than the available disk space shown.

> Enter the complete drive and path for the preferences location. This is the
directory in which the personal spelling dictionary (SPLDICT.PD) and
the personal configuration file (VPWINL.INF) is stored. If the directory
specified does not exist, it will be created.

The Custom installation option allows you to specify the components you
wish to installed. When the Custom installation option is selected, the
Ventura Publisher Custom Installation dialog box is displayed.
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The disk space required for each component selected for installation will be
displayed next to the destination entry field for the selected component.
Additionally, the total space required and space available for each drive
selected as a destination drive (as set in the destination entry fields) will be
displayed at the bottom of the screen.

If the required disk space is greater than the available disk space, an alert
box will be displayed when the setup application exhausts the available
disk space. However, if you are installing the Ventura Publisher com-
ponents over previous installations of the components, the amount of disk
space used by these components is not added to the available space shown.
In this situation, there may be sufficient space available for the installation
even though the space required is greater than the available disk space
shown.

> Check the check boxes for the components you wish to install.

> If the Ventura Publisher component check box is checked, use the drive
selection buttons next to the Ventura Publisher destination field to select
the drive on which Ventura Publisher is to be installed. Only the destina-
tion drive can be modified. The destination directory must be
VENTURA, and cannot be modified.

> If desired, modify the Preferences Location entry field to store the
personal dictionary file (SPLDICT.PD) and the personal configuration
file (VPWINLINF) on a drive or in a director; other than the VENTURA
directory in which the Ventura Publisher application files are to be
installed. If the directory specified does not exist, it will be created.

15
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Ventura
Scan/Ventura
Separator

Examples

Design Gallery

If either or both the Ventura Scan and Ventura Separator component check
boxes are checked, the destination fields for these options will automat-
ically be set to that of the Ventura Publisher destination field if the Ventura
Publisher component check box is checked. The drive selection button for
the Ventura Scan and Ventura Separator components will be inactive.

If Ventura Publisher Windows Edition 4.1 is not already installed, you must
check the Ventura Publisher component check box when installing the
Ventura Scan and Ventura Separator components. Ventura Scan and
Ventura Separator must be installed in the same directory in which the
Ventura Publisher Windows Edition 4.1 application files are installed.

If the Ventura Publisher component check box is cleared, the drive selec-
tion buttons for the Ventura Scan and Ventura Separator components will
be active if the corresponding check box is checked. Use the drive selection
buttons to select the destination drive for the component. If both check
boxes are checked, changing the destination drive for one of the com-
ponents will change the destination drive for the other.

If the Examples component check box is checked, modify the destination
drive and path if desired.

To specify Design Gallery categories or documents for installation, click on
the Select button. When you click on the Select button, the Design Gallery
Categories dialog box is displayed.

Simply checking the Design Gallery check box will not select any of the
Design Gallery documents for installation. You must click on the Select but-
ton and the desired category button to select the documents for installation.

The dialog box displays buttons for each of the Design Gallery categories
available. Each of the Design Gallery categories contain a number of in-



dividual documents. Clicking on any of the Design Gallery category but-
tons displays a dialog box similar to the following.

[S® By default, the document check boxes for each of the categories is cleared.
To install a document for any category, you must select the category button
and check the check box for all documents you want to install.

This dialog box allows you to select individual Design Gallery documents
for installation. When a check box for a document is cleared, that document
will not be installed.

» Check or clear the document check boxes as desired.

> Click on the Continue button to accept your choices and return to the
Design Gallery Category dialog box.

> Select other Design Gallery categories and documents in the same man-
ner.

> When you are satisfied with your Design Gallery selections, click on the

Continue button in the Design Gallery dialog box to return to the
Ventura Publisher Custom Installation dialog box.

Workstation

The Workstation installation option will not install any program files. This
option is used to install a Ventura Publisher icon, and set the preferences
location for workstations running Ventura Publisher from the network
server.

17
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Ventura Publisher must already be installed on the network server system
before installing for a workstation.

When the Workstation installation option is selected, the Destination
dialog box is displayed.

» Use the drive select buttons to select the network server drive on which
Ventura Publisher is installed.

> Enter the complete drive and path for the preferences location. This is the
directory in which the personal spelling dictionary (SPLDICT.PD) and
the personal configuration file (VPWIN.INF) is stored. The preferences
directory should not be the VENTURA directory. The preferences direc-
tory should be a unique directory for each workstation user (e.g., the
user’s HOME directory). If the directory specified does not exist, it will
be created. '
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Configuration

This section describes how to use the SERNSTAL application to register
network workstations so that they can run Ventura Publisher from the
program files installed on the network server.

This section also describes how to use the button bar editor application to
customize the Ventura Publisher button bar.

19
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Registering workstations
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In order for multiple workstations to run Ventura Publisher from the
program files installed on the server, you must register the workstations by
installing additional Ventura Publisher nodes. Ventura Publisher must be
installed on the server prior to installing the nodes.

If you are upgrading from a previous version of Ventura Publisher for
which you have registered network seats, you must also obtain and install
Network Node Kit upgrades.

The original Ventura Publisher APPLICATION disk used to install Ventura
Publisher on the server contains a single node that can be registered.
Additional nodes can be added by purchasing Network Node Kits or
complete Ventura Publisher software packages.

The installation of nodes can be performed from any workstation having
complete access rights to the VENTURA directory.

Installing additional nodes permits multiple users to run Ventura Publisher
from a single copy installed on the server. Installing an additional node
increments the number of users able to run Ventura Publisher from the copy
installed on the server, but does not assign that node to any particular
workstation. If you have a total of five nodes installed on the network, a
maximum of five users can run Ventura Publisher installed on the server
from any five workstations having access to the program.

To install additional nodes:

> Purchase a separate Network Node Kit for each node that is to have
access to Ventura Publisher on the network.

> With Windows version 3.0 or above running, insert the UTILITIES disk
into appropriate floppy disk drive.

> Select the File menu from the Program Manager File menu.
> In the Command Line entry field, type:
[drive] : \UTILITY\SERNSTAL

where [drive] is replaced with the letter of the floppy disk drive
containing the UTILITIES disk.



> Press the Enter key or click on the OK button. The Ventura Network Seat
Registration dialog box appears.

Network Node Drive: Seat ID: |Ver 4- 041058

'Examine Node Drive Version 4 Version 3

Ventura Publisher Install Drive: @
Number of Seats Installed: III |:l

List of Installed Seat IDs: 041058

|s‘&d‘d Seat |

_Finished

> If you intend to install Version 3.0 Network Node Kits, you will need to
enable the version 3.0 installation function. This can be done by selecting
the Install VP 3.x Seats option from the Options menu as shown below.
A check mark next to the option means that the installation option is
enabled. If you are installing Network Nodes Kits for only one version,
it is recommended that you disable the install option for the other
version.

+ Install VP 4.x Seats
+ Install VP 3.x Seats

Exit
About SernStal...

> Insert the Network Node Kit disk in the appropriate floppy drive.
Remove the Ventura Publisher Utilities disk if necessary.

The Ventura Publisher Application disk contains a network node serial
number that may be registered.

> In the Network Node Drive entry field, enter the floppy drive letter in
which the Network Node Kit disk is inserted.

> In the Ventura Publisher Install Drive entry field for the appropriate
version, enter the network drive letter on which that version of Ventura
Publisher is installed.

> If you are installing several Network Node Kits, you may wish to view
the serial number on the floppy disk currently in the disk drive to ensure

21
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it contains a valid serial number and is not a duplicate of one already
registered. To view a serial number on the floppy disk, click on the
Examine Node Disk button.

The serial number and serial number version of the Network Node Kit disk is
displayed in the Seat ID field. This number can be compared with the serial
numbers in the List of Installed Seat IDs to ensure that the number has not
been previously registered.

To register the network node serial number, click on the Add Seat
button. The network node serial number will be registered. The Number
of Seats Installed field will be updated to reflect the addition of a new
network seat, and the newly registered serial number will appear in the
List of Installed Seat IDs.

Remove the Network Node Kit disk from the disk drive and repeat the
previous five steps for each Network Node Kit you wish to register.

When all network seats have been registered, exit the program by select-
ing Exit from the Options menu, or by clicking on the Finished button.

SERNSTAL specific error messages

This disk
contains a
previously

installed serial
number

This disk does
not contain a
serial number

This disk
contains an
invalid serial
number

The following is a description of additional messages that may appear
while using SERNSTAL.

This message appears if the serial number on the Network Node Kit or
Ventura Publisher Application currently in the floppy drive has already
been registered. Insert a different network node disk, or Ventura Publisher
APPLICATION disk, and try again.

This message occurs if the disk currently in the floppy disk does not contain
a serial number.. Ensure that either a Network Node Kit or a Ventura
Publisher Application floppy disk is inserted in the floppy drive before
attempting to register a seat.

This message occurs when the serial number file on the Network Node Kit
or Ventura Publisher Application floppy disk is from a sales demo package,
is corrupt, or has been altered.
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Customizing the button bar

The button bar in Ventura Publisher can be customized using the Button
Configuration application that was installed with Ventura Publisher.

Ventura Publisher allows three different button configurations. Each con-
figuration corresponds to a different video resolution as determined by the
resolution of the video driver installed in Windows. The three configura-
tion resolutions are:

*« VGA - 640 x 480 resolution

* Super VGA - 800 x 600 resolution

» Extended VGA - 1024 x 768 resolution and above

The button configuration is stored in the VPWIN.INI file located in the

directory in which Windows is installed. This INI file should not be edited
using an application other than the button configuration application.

Description

> Open Ventura Publisher window in the Windows Program Manager and
double-click on the Button Configuration icon. The Button Bar Editor is
displayed.
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Button bar The button bar displayed is a representation of the Ventura Publisher

Category list box
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Buttons box

button bar configuration for the current video resolution. The tool buttons
cannot be changed or replaced, nor can any option or function buttons be
added to that row of the button bar. Clicking on a button in the button bar
will display a description of that button in the button description area.

Each of the tool buttons, when selected, display a set of option buttons. The
following is a list of the tool buttons and the option buttons available for
editing when the tool button is selected.

Selector tool — Not available for selection.

Add Frame tool — Displays the option buttons available when the Selector
tool is used to select a frame.

Paragraph tool — Displays the option buttons available when a paragraph
is selected using either the Paragraph tool or the Text tool. The option
button configuration is the same for both.

Text tool - Displays the options available when a selected range of text is
highlighted using the Text tool.

Graphic tools — Displays the options available when the Selector tool is
used to select a Ventura Publisher graphic. Each of the graphic buttons
display the same set of option buttons.

The options in the Category list box control which buttons are displayed in
the Buttons box. A category option will only be available if the option
buttons for that category can be used with the currently selected tool button
(e.g., the Frame, Paragraph, Text, and Graphic category options will not be
available if the Table tool button is selected in the button bar).

The File, Edit, and Chapter categories will always be available regardless
of the tool selected. The buttons for these categories correspond to the but-
tons used in the function button area of the button bar. The buttons for these
category options cannot be used as tool option buttons.

Additionally, tool option buttons cannot be used in the function button area
of the button bar.

The Buttons box displays all of the buttons that can be placed in the button
bar for the currently selected category. Clicking on a button in the button
box will display a description of that button in the button description area.
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Editing the button bar

Saving the
configuration

Using the mouse, you can interactively customize the button bar as follows:

> If you wish to edit the tool option buttons, click on the desired tool
button in the button bar. When you click on one of the tool buttons, the
option buttons change to represent the options most commonly used
with that tool button.

> Selected the desired Category list box option.

> To delete a button from the button bar, simply drag the button off of the
button bar.

> To insert a button between two buttons in the button bar, drag the
desired button from the Button box and place it between the two buttons
in the button bar.

You can continue to add buttons to the button bar as long as space is
available in the button bar for more buttons. If the space for buttons is filled,
and you insert a new button, the button on the right end of the row will be
automatically deleted.

To save the button bar configuration, select the Save option from the File
menu. To quit without saving the configuration, select the Exit option from
the File menu and then click on the No button when the alert box is
displayed.
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Utilities

Ventura Publisher Windows Edition 4.1 includes a number of utilities. A
description of these utilities and their use are described in this section.
These utilities are:

VP43.EXE - Utility for converting chapter files saved in version 4.0 and
above to 2.0/3.0 format.

FIXCHP.EXE - Utility for updating chapter file pointers after chapter files
have been copied using Windows File Manager or DOS Copy:
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VP43.EXE

This utility allows you to convert chapters files saved in version 4.0 and
above to 2.0/3.0 format.

The conversion utility will generate a backup of the original chapter and
style sheet files. The extensions for these files will be &HP for chapters files,
and &TY for style sheet files. The backup files will be 4.1 version files.

To use the VP43.EXE utility:

> Copy the VP43.EXE file from the UTILITY directory on the Ventura
Publisher Windows Edition 4.1 UTILITIES disk to the directory contain-
ing the chapter and style sheet files you wish to convert, or to a directory
listed in the PATH statement of your AUTOEXEC.BAT file.

> Change to the drive and directory containing the chapter and style sheet
files you wish to convert.

> At the DOS prompt, type:
VP43 [filename] C2 C3 C4 C5 C6 C7

where [filename] is replaced with the name of the chapter you wish
to convert to 2.0/3.0 format. The chapter name and extension cannot
contain any DOS wildcard characters. C2 through C7 are replaced with
the version 4.1 style sheet color numbers you wish to be saved in the
version 2.0/3.0 style sheet.

For example:
VP43 SCOOP.CHP 17 4 5 6 21 22
would convert the 4.1 format chapter and associated style sheet to 2.0/3.0

format. Color numbers 17, 4, 5, 6, 21, and 22 in the 4.1 format style sheet
would become colors 2, 3, 4, 5, 6, and 7 in the 2.0/3.0 format style sheet.

If you do not specify any color numbers on the command line, VP43 will
save the eight default colors (numbers 0 through 7) from the 4.1 format style
sheet to the 2.0/3.0 format style sheet.
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Determining 4.1 style sheet color numbers

To determine the color numbers of the color saved in a 4.1 format style
sheet:

> With Ventura Publisher 4.1 running, load the style sheet you wish to
convert to 2.0/3.0 format.

> Click on the Paragraph tool button and click on the Update Tag List
option button. The Update Tag List dialog box is displayed.

> Click on the Print Stylesheet button.

> Ventura Publisher will prompt you for file name under which to save a
text file containing the settings (including the color numbers) for the .
loaded style sheet. Enter a path and file name for the file, and then click
on the OK button.

The text file will be saved as a generated (GEN) file. This file can be loaded
into Ventura Publisher and formatted using the STYLELOG.STY style sheet
included with the Ventura Publisher examples. You can then print the
chapter to obtain a listing of all color numbers for the colors saved in the
style sheet.

Limitations

The Ventura Publisher style sheet format for versions prior to 4.0 allows
only eight colors to be defined (two of which, white and black, cannot be
changed). When converting a style sheet from 4.1 format to 2.0/3.0 format,
you are allow to save only six of the colors defined in the 4.1 style sheet.

Colors applied to paragraph tags and frames that are not saved in the
2.0/3.0 format style sheet will be converted to black (color number 1).

You may notice differences in the color settings when a color is converted
to 2.0/3.0 format. This happens when a color is defined in a 4.1 format style
sheet in a color model other than CMYK. The differences occur as a normal
part of translating the color from one color model to CMYK. These differen-
ces will be minimal.

Ventura Publisher graphics.(stored in the VGR file), text files, and caption
text (stored in the CAP file) such as headers and footers are unaffected by
VP43. Consequently, colors assigned to Ventura Publisher graphics and
caption text will not be converted, and will have to be changed manually.



Additionally, text assigned color either by selecting a range of text using the
text tool and applying a color, or entering color codes in the text file, will
not be converted and will have to be converted manually.

Text and image/line art file formats are also unaffected by the converter. If
the file format of a text or image/line art file is not supported in the earlier
version, you will receive an error message stating that one or more of the
files are not in the proper format, or cannot be converted when you attempt
to open the chapter. These files should be converted to a format supported
in the earlier version before the chapter is converted.

References to files saved in a format not supported by the version of
Ventura Publisher in which the chapter is opened, will be removed from the
chapter if saved in that version of Ventura Publisher.
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FIXCHP.EXE
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The chapter (CHP) file lists the name and location of all of the files as-
sociated with the chapter. If you use the Windows File Manager or the DOS
COPY command to copy chapter files, the file location pointers listed in the
CHP file do not change and will probably be wrong.

This utility will update the pointers in the chapter file that refer to the
various components of a chapter (e.g., text files, image files) after the files
have been copied using the Windows File Manager, or the DOS COPY
command.

FIXCHP will also update the width table entry of the style sheet used in the
chapter.

All of the files associated with the chapter (including the width table) must
be copied to the same directory. FIXCHP will only work with CHP files, not
publication (PUB) files. Publications will have to be reconstructed from the
updated chapter files.

To use FIXCHP:

> Copy the FIXCHP.EXE file from the UTILITY directory on the Ventura
Publisher Windows Edition 4.1 UTILITIES disk to the directory contain-
ing the chapter files, or to a directory listed in the PATH statement of
your AUTOEXEC.BAT file.

> Change to the drive and directory containing the chapter and associated
files.

> At the DOS prompt, type:
FIXCHP [CHP name]
where [CHP name] is replaced with the name (including file extension)

of the chapter you want updated. The chapter name and extension can
contain any valid DOS wildcard characters.
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